
WiFi & BLE

1 x Serial TTL

RX: GPIO 14

TX: GPIO 16

GPRS/GSM

1 x Serial TTL

RX: GPIO 14

TX: GPIO 16

1 x Direct Arduino Pin

RST: GPIO 2

LoRa

3 x Direct Arduino Pin

RST: GPIO 3

SS: GPIO 23

INT: GPIO 2

DALI

1 x Serial TTL

RX: GPIO 14

TX: GPIO 16

10 bit

0 to 10 Vdc

0 to 24 Vdc

24 Vdc

10 Vdc

39 kΩ

Value

Resolution

Range (An)

Range (Dig)

Rated Voltage (Dig)

Rated Voltage (An)

Input Impedance

Parameter

Analog/Digital Inputs

I max. 2 mA

Max. Freq.

Isolation

1.5 KHz

Optocoupled

5 to 24 Vdc

24 Vdc

15 KHz

Optocoupled

2 mA

Value

Range

Rated Voltage

Max. Freq.

Isolation

I min.

Parameter

Dig. Isolated Inputs

5 to 24 Vdc

24 Vdc

2 KHz

Optocoupled

70 mA

Value

Range

Rated Voltage

Max. Freq.

Isolation

I max.

Parameter

Dig. Isolated Outputs

Protection
Diode Protected

for Relay

*Resistive Load

230 Vac (AC)

4 A (AC)

2 A (DC)

24 Vdc (DC)

Value

Operating Mode

Voltage Range

Maximum Current

Parameter

Relays

Isolation Optocoupled

8 bit

0 to 10 Vdc

0 to 24 Vdc

24 Vdc

10 Vdc

20 mA

Value

I. max.

Resolution

Range

Range (Dig)

Rated Voltage (Dig)

Rated Voltage (An)

Parameter

An/Dig/PWM Outputs

Max. Freq. 4 Hz

Protection

Isolation

Diode Protected

for Relay

Optocoupled

WiFi & BLE

Model: ESP32-WROOM-32

Type: CPU / Microcontroller Module

Key Features: Wi-Fi 802.11 b/g/n (2.4 GHz), up

to 150 Mbps, Bluetooth v4.2 (BR/EDR and

BLE), Up to 520 KB SRAM, 4 MB Flash,

Integrated Hall sensor and temperature sensor,

Ultra-low-power co-processor for deep sleep

modes

Applications: IoT devices (sensors, smart home

appliances), Wearables and portable electronics,

Industrial automation and monitoring, Wireless

data logging, Remote control and telemetry

GPRS/GSM

Model: SIM800L

Type: GSM/GPRS Cellular Communication Module

Key Features: Quad-band GSM/GPRS (850 / 900

/ 1800 / 1900 MHz) – works worldwide, GPRS

multi-slot class 12 / class 10 (optional), Built-in

TCP/IP stack (supports HTTP, FTP, SMS, voice,

etc.), Supports UART interface (AT command set

compatible).

Applications: IoT and M2M projects requiring

remote communication, SMS-based control

systems, Remote data logging (e.g., weather

stations, sensors)

LoRa

Model: RFM95

Type: SX1276 LoRa Module

Key Features: Compliant with LoRaWAN® protocol

(Long Range Wide Area Network), Integrated

Semtech SX1276 LoRa transceiver, Configurable

spreading factor, bandwidth, and coding rate for

flexible deployment, Operates in multiple frequency

bands (868 MHz, 915 MHz, etc.)

Applications: IoT sensor networks (smart agriculture,

environmental monitoring), Remote telemetry and

industrial automation, Wireless sensor nodes in low-

power wide-area networks (LPWAN)

Expansion Board Resources
Certain I/O pins may be

unavailable depending on the

expansion board.

Operating Ambient Temp.

Storage Ambient Temp.

Operating Ambient Humidity

Ambient Environment (Oper.) 

0º to 60ºC

-20º to 60ºC

10% to 90% (No condensation)

Free from corrosive gases

Environmental Specifications

Arduino Board

Microcontroller

Flash Memory

SRAM

Arduino Leonardo

ATmega32u4

32 KB (4 KB used by the bootloader)

2.5 KB

Controller Specifications

EEPROM 1 KB

Clock Speed 16 MHz

Input Voltage

Insulation Resistance

Input Rated Voltage

Rated Power

Dielectric Strength

Maximum Current

12 to 24Vdc (Fuse protection (2.5A) Polarity protection)

20MΩ min.at 500Vdc between the AC terminals and

the protective earth terminal.

24 Vdc

30 W (Refer to Model Comparison table)

2.300 VAC at 50/60 Hz for one minute with a leakage current of

10mA max. Between all the external AC terminals and the

protective ground terminal.

1.5 A

Technical Features 

Communications & Features

RS-485 (Half-Duplex or Full-Duplex), RS-232, I2C, SPI, Serial TTL,

USB 2.0 Type-Micro (see the UserGuide for switches and jumpers

configuration)

1

Ardbox Family Datasheet

*If inductive loads are used, we recommend

installing an RC snubber filter. The RC

values must be calculated based on the

characteristics of the connected load.

Original

Arduino Leonardo

included

Available Expansion Boards

DALI

Model: DALI 2 CLICK

Type: DALI Communication Interface Module

Key Features: Compliant with DALI-2 standard

(Digital Addressable Lighting Interface – IEC

62386), Supports bidirectional communication

with DALI networks, Integrated TPS65582 DALI

transceiver (by Texas Instruments), Galvanically

isolated interface using optocouplers.

Applications: Smart lighting control in building

automation systems, Energy-efficient lighting

systems, Automated lighting scenes and

scheduling, IoT-enabled lighting systems



10 bit

0 to 10 Vdc

0 to 24 Vdc

24 Vdc

10 Vdc

39 kΩ

Value

Resolution

Range (An)

Range (Dig)

Rated Voltage (Dig)

Rated Voltage (An)

Input Impedance

Parameter

Analog/Digital Inputs

I max. 2 mA

Max. Freq.

Isolation

1.5 KHz

Optocoupled

5 to 24 Vdc

24 Vdc

15 KHz

Optocoupled

2 mA

Value

Range

Rated Voltage

Max. Freq.

Isolation

I min.

Parameter

Dig. Isolated Inputs

5 to 24 Vdc

24 Vdc

2 KHz

Optocoupled

70 mA

Value

Range

Rated Voltage

Max. Freq.

Isolation

I max.

Parameter

Dig. Isolated Outputs

Protection
Diode Protected

for Relay

*Resistive Load

230 Vac (AC)

4 A (AC)

2 A (DC)

24 Vdc (DC)

Value

Operating Mode

Voltage Range

Maximum Current

Parameter

Relays

Isolation Optocoupled

8 bit

0 to 10 Vdc

0 to 24 Vdc

24 Vdc

10 Vdc

20 mA

Value

I. max.

Resolution

Range

Range (Dig)

Rated Voltage (Dig)

Rated Voltage (An)

Parameter

An/Dig/PWM Outputs

Max. Freq. 4 Hz

Protection

Isolation

Diode Protected

for Relay

Optocoupled

WiFi & BLE

1 x Serial TTL

RX: GPIO 14

TX: GPIO 16

GPRS/GSM

1 x Serial TTL

RX: GPIO 14

TX: GPIO 16

1 x Direct Arduino Pin

RST: GPIO 2

LoRa

3 x Direct Arduino Pin

RST: GPIO 3

SS: GPIO 23

INT: GPIO 2

DALI

1 x Serial TTL

RX: GPIO 14

TX: GPIO 16

Expansion Board Resources
Certain I/O pins may be

unavailable depending on the

expansion board.

1

Ardbox Family Datasheet

*If inductive loads are used, we recommend

installing an RC snubber filter. The RC

values must be calculated based on the

characteristics of the connected load.

WiFi & BLE

Model: ESP32-WROOM-32

Type: CPU / Microcontroller Module

Key Features: Wi-Fi 802.11 b/g/n (2.4 GHz), up

to 150 Mbps, Bluetooth v4.2 (BR/EDR and

BLE), Up to 520 KB SRAM, 4 MB Flash,

Integrated Hall sensor and temperature sensor,

Ultra-low-power co-processor for deep sleep

modes

Applications: IoT devices (sensors, smart home

appliances), Wearables and portable electronics,

Industrial automation and monitoring, Wireless

data logging, Remote control and telemetry

GPRS/GSM

Model: SIM800L

Type: GSM/GPRS Cellular Communication Module

Key Features: Quad-band GSM/GPRS (850 / 900

/ 1800 / 1900 MHz) – works worldwide, GPRS

multi-slot class 12 / class 10 (optional), Built-in

TCP/IP stack (supports HTTP, FTP, SMS, voice,

etc.), Supports UART interface (AT command set

compatible).

Applications: IoT and M2M projects requiring

remote communication, SMS-based control

systems, Remote data logging (e.g., weather

stations, sensors)

LoRa

Model: RFM95

Type: SX1276 LoRa Module

Key Features: Compliant with LoRaWAN® protocol

(Long Range Wide Area Network), Integrated

Semtech SX1276 LoRa transceiver, Configurable

spreading factor, bandwidth, and coding rate for

flexible deployment, Operates in multiple frequency

bands (868 MHz, 915 MHz, etc.)

Applications: IoT sensor networks (smart agriculture,

environmental monitoring), Remote telemetry and

industrial automation, Wireless sensor nodes in low-

power wide-area networks (LPWAN)

Available Expansion Boards

DALI

Model: DALI 2 CLICK

Type: DALI Communication Interface Module

Key Features: Compliant with DALI-2 standard

(Digital Addressable Lighting Interface – IEC

62386), Supports bidirectional communication

with DALI networks, Integrated TPS65582 DALI

transceiver (by Texas Instruments), Galvanically

isolated interface using optocouplers.

Applications: Smart lighting control in building

automation systems, Energy-efficient lighting

systems, Automated lighting scenes and

scheduling, IoT-enabled lighting systems

12 to 24 Vdc ((2.5 A) Polarity protection)

20W

1.5 A

30W

Electrical Features

Power supply voltage

Power consumption

I max.

Rated Power

Input rated voltage 24 Vdc

20 - 26 AWG spring push-in

16 - 28 AWG screw

Ambient humidity (operating) 10 % to 90 % (no condensation)

Ambient environment (operating)

Ambient temperature (storage)

With no corrosive gas

-20 º to 60 ºC

Physical Characteristics

Dimensions H x W x D

Connector specifications 

119.5 x 45 x 101

IP grade protection

DIN Rail

IP20

TS35

Weight 350 g max

Communication connector

Power supply connector

Technical Features

CPU ATmega32u4

Clock speed 16 MHz

SRAM 2.5 KB

EEPROM 1 KB

Interface Features

RS-485
Half / Full Duplex port, 120Ω termination resistor. Selectable via

internal jumpers

RS-232 Selectable via internal jumpers

SPI 5V, direct from ATmega32u4

I2C 5V, direct from ATmega32u4





Steps to install Industrial Shields equipment in the Arduino IDE:

1.Open the Arduino IDE (version 1.8.19 or later). You can download

it from: https://www.arduino.cc/en/Main/Software

2. In the Arduino IDE, go to the File menu and click Preferences.

3. In the "Additional Board Manager URLs" field, add this URL:

http://apps.industrialshields.com/main/arduino/boards/packag

e_industrialshields_index.json

4.Click OK to close the Preferences window.

5.Go to the Tools menu, open the Board submenu, and click

Boards Manager.

6. In the Boards Manager window, type industrialshields-avr into the

search bar. Select the result from the list and click Install.

7.Once the installation is complete, close the Boards Manager.

You will now be able to select the desired PLC from Tools > Board,

such as M-Duino, Ardbox, etc.

 

For more information, visit:

https://www.industrialshields.com/blog/arduino-industrial-1/how-to-

install-industrial-shields-boards-in-the-arduino-ide-63

Install Arduino IDE and the Industrial Shields boards
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References

The references are: 0EE00100MM00

E stands for the Expansion Board:

EE = 04 → DALI

EE = 06 → GPRS

EE = 07 → WiFi-BLE

EE = 15 → LoRa

M stands for Model:

MM = 12 → Analog

MM = 13 → Relay

Ardbox Family Datasheet

Unused pins should not be connected. Ignoring the directive may damage the

controller. 

 

Before using this product, it is the responsibility of the user to read the

product’s User Guide and all accompanying documentation.

 

Industrial Shields PLCs must be powered between 12Vdc and 24Vdc. If a

higher voltage is supplied to the equipment can suffer irreversible damage.

 

Maintenance must be performed by qualified personnel familiarized with the

construction, operation, and hazards involved with the control. 

 

Maintenance should be performed with the control out of operation and

disconnected from all sources of power. 

 

The Industrial Shields Family PLCs are Open Type Controllers. It is required

that you install the Ardbox family PLC in a housing, cabinet, or electric control

room. Entry to the housing, cabinet, or electric control room should be limited

to authorized personnel.

Inside the housting, cabinet or electric control room, the Industrial Shields

PLC must be at a minimum distance from the rest of the components of a

minimum of 25 cm, it can be severely damaged.

 

Failure to follow these installation requirements could result in severe

personal injury and/or property damage. Always follow these requirements

when installing Ardbox family PLCs. 

 

In case of installation or maintenance of the PLC please follow the

instructions marked in the Installation and Maintenance section on the User

Guide. 

 

Do not disconnect equipment when a flammable or combustible atmosphere

is present. 

Disconnection of equipment when a flammable or combustible atmosphere

is present may cause a fire or explosion which could result in death, serious

injury and/or property damage.

This equipment does not include galvanic isolation between the grounds of

the different systems. This means that if an external device or sensor that

shares the same ground reference (GND) with the system is connected, any

potential difference between these grounds could damage the connected

components. To avoid issues with interference, ground loops, or damage to

external equipment, ensure that all connected devices share the same

ground reference or use systems with appropriate isolation. The

recommendations in this case are:

Connection Review: Verify that all ground connections are properly made

and that there are no significant potential differences between them.

Use of Isolation: Consider using galvanic isolators or isolation

transformers if it is necessary to connect equipment with different

ground references.

Warnings

Visit our Channel

Use our chat service

Check the user guides

You can contact with us using the best channel for you:

Visit our Blog, Forum or Ticketing system

www.industrialshields.com

support@industrialshields.com@

Technical Support

Indicates that the equipment is suitable for direct current only; to

identify relevant terminals

Indicates that the equipment is suitable for alternating current

only; to identify relevant terminals

To identify the control by which a pulse is started.

To identify an earth (ground) terminal in cases where neither the

symbol 5018 nor 5019 is explicily required.

To identify the switch by means of which the signal lamp(s) is

(are) switched on or off.

CE marking indicates that a product complies with applicable

European Union regulations

Indicates a potentially hazardous situation which,

if not avoided, could result in death or serious injury

To indicate hazards arising from dangerous voltages

Symbology

Camí del Grau, 25 | 08272, Sant Fruitós de Bages (Barcelona) | SPAIN
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